
Selecting Additional Features
1. Select one or more of the following additional features.

* Audit highlights or produces a report on all formulas, or the relationships of values and formulas, 
in the current file or in all active files; also highlights or produces a report on circular references, 
file links, or DDE links.

* Backsolver finds values for one or more cells that make the result of a formula equal to a value 
you specify.

* Solver analyzes data in a worksheet and shows you a variety of possible answers to a problem 
you define. An answer satisfies constraints you specify. You can start with any worksheet model 
that contains formulas and values you want to experiment with.

You work with Solver by creating a worksheet model that contains a Solver problem, solving the 
problem, and viewing and saving the results.

* Lotus Dialog Editor lets you create custom dialog boxes for use in 1-2-3.

* Macro Translator translates each {ALT} keystroke command in a 1-2-3 for Windows Release 1 to 
its fully qualified 1-2-3 Release 4 equivalent.

If your current .WK3 files contain {ALT} keystroke macros that you want to run with 1-2-3 Release 
4, install the Macro Translator.

* The Translate utility is a program that lets you convert data files to and from the 1-2-3 Release 4 
file format. Because you can use Translate only from your hard disk, Lotus recommends that you 
transfer the Translate utility to your 1-2-3 Release 4 program directory now unless you are certain
that you will never need to use it.

* Version Manager for Lotus Notes 

* Spell Check checks for misspelled and repeated words in your worksheets.

2. Choose OK or press ENTER.

See also
Install Glossary



Inserting 1-2-3 Disks
Each time Install finishes transferring files from a disk, it prompts you to insert another disk.

If you inserted the wrong disk, remove the disk and insert the disk Install is prompting you for.

If the diskette drive is not ready, make sure the correct disk is properly inserted in the drive and close the 
drive door; then select OK or press ENTER to continue transferring files.



Specifying the Lotus Common Directory
This directory stores files shared by Lotus Windows products. These settings are stored in the 123R4.INI
file as default settings and take effect automatically whenever you start 1-2-3.

Specify the disk drive and directory name of the Lotus common directory, if it does not already exist. 

1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the shared files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space for the shared files are displayed in parentheses.

2. Install displays the default Lotus Common directory name, \LOTUSAPP, in the "Lotus Common 
Directory" text box.

Lotus recommends that you accept the default directory name, but you can change it.

If you change the directory name, remember that the directory name cannot contain more than eight 
characters. If you use subdirectories in your path, each subdirectory name cannot contain more than 
eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

See also
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Specifying the Lotus Common Directory
When you install 1-2-3 on a server, you must specify the disk drive and directory name of the Lotus 
Common directory that will store files shared by Lotus Windows products, then make the directory 
accesible to users.

Specifying the drive and directory
1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to the server and displays the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enought space 
for the shared files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note    Drives that do not contain enough space for the shared files are displayed in parentheses.

2. Install displays the default 1-2-3 directory name, \LOTUSAPP, in the Lotus Common Directory text 
box.

Lotus recommends that you accept the default directory name, but you can change it.

If you change the directory name, remember that the directory name cannot contain more than eight 
characters. If you use subdirectories in your path, each subdirectory name cannot contain more than 
eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

Making the Lotus Common directory accessible to users
After the server directories are created, you need to use your network software to make the directories 
accessible to network users. This process involves giving each directory a network name and assigning 
access privileges to it. See Creating the Lotus Common directory on your network for recommended 
sharenames, where applicable, and access privileges for supported networks.

Creating the Lotus Common directory on your network
For information about access privileges and share names for your network, select your network from the 
following list.

Artisoft LANtastic   version 4.1  

Banyan VINES version 5.5
DEC PATHWORKS version 4.1
IBM LAN Server version 3.0
Microsoft LAN Manager version 2.1a or 2.2
NCR StarGroup 3.5 version 2.1A
Novell NetWare 386 version 3.11
Novell SFT NetWare 286 version 2.15c
Novell Advanced NetWare 286 version 2.15c
Novell NetWare 286 version 2.2



Specifying the Drive for the Lotus Common Directory
Your network administrator created the Lotus common directory, which stores files shared by Lotus 
Windows products, on the server.

1. Type a drive letter in the Drive letter text box.

If you do not know the drive letter for the Lotus directory, ask you network administrator.

2. Choose OK or press ENTER.

See also
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Upgrading a Previous Release
You chose to install 1-2-3 Release 4 in an existing 1-2-3 for Windows directory.

If you choose OK, Install deletes obsolete program files from the previous release. Install does not delete
your worksheet files, SmartIcons macro files, or custom settings.

If you choose Cancel, specify a different 1-2-3 directory name.



Upgrading a Previous Release
Install detects a previous release of 1-2-3 for Windows in this directory.

If you choose to install 1-2-3 Release 4 in the existing directory, Install deletes obsolete program files 
from the previous release. Install does not delete your worksheet files, SmartIcons macro files, or custom
settings.

If you choose to install 1-2-3 Release 4 in a new directory, Install does not delete any files.



Specifying the Licenser Utility Directory
When you install 1-2-3 on a server, you must specify the disk drive and directory name of the Licenser 
Utility directory that will store the Licenser utility.

Specifying the drive and directory
1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
to fit the Licenser utility.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive    
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space to store the Licenser utility are displayed in 
parentheses.

2. Install displays the default Licenser directory name, \LICENSER, in the Licenser Directory text box.

Lotus recommends that you accept the default Licenser directory name, but you can change it.

If you change the Licenser directory name, remember that the directory name cannot contain more 
than eight characters. If you use subdirectories in your path, each subdirectory name cannot contain 
more than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

Creating the Licenser Utility directory on your network
For information about access privileges and share names for your network, select your network from the 
following list.

Artisoft LANtastic   version 4.1  

Banyan VINES version 5.5
DEC PATHWORKS version 4.1
IBM LAN Server version 3.0
Microsoft LAN Manager version 2.1a or 2.2
NCR StarGroup 3.5 version 2.1A
Novell NetWare 386 version 3.11
Novell SFT NetWare 286 version 2.15c
Novell Advanced NetWare 286 version 2.15c
Novell NetWare 286 version 2.2



Specifying the License Directory
When you install 1-2-3 on a server, you must specify the disk drive and path of the directory that will 
store the license files, which regulate the number of users who can use 1-2-3 Release 4 for Windows at 
the same time. The directory also contains the log file, which shows the date and time that users tried to 
run 1-2-3 but were denied access. The name of the license directory must be 123W.V40. 

Specifying the drive and path
1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to the server and displays the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the license files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note  Drives that do not contain enough space to store the license files are displayed in parentheses.

2. Enter the path to the License directory in the Path text box.

Each directory name in the path cannot contain more than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

Making the program directory accessible to users
After the server directories are created, you need to use your network software to make the directories 
accessible to network users. This process involves giving each directory a network name and assigning 
access privileges to it. See Creating the License directory on your network for recommended 
sharenames, where applicable, and access privileges for supported networks.

Creating the License directory on your network
For information about access privileges and share names for your network, select your network from the 
following list.

Artisoft LANtastic   version 4.1  

Banyan VINES version 5.5
DEC PATHWORKS version 4.1
IBM LAN Server version 3.0
Microsoft LAN Manager version 2.1a or 2.2
NCR StarGroup 3.5 version 2.1A
Novell NetWare 386 version 3.11
Novell SFT NetWare 286 version 2.15c
Novell Advanced NetWare 286 version 2.15c
Novell NetWare 286 version 2.2





Choose Country Driver and Sort Order
Lets you change your country driver and collating sequence.

1. Select a country driver and sort order combination from the list box.

2. Choose OK or press ENTER.

About sort order
The sort order determines the order in which 1-2-3 sorts different types of labels when you use Range 
Sort or Query Sort. The following table shows the three sort orders in ascending order. If you use 
descending order, the sequences shown here are reversed.

ASCII
Blank cells
Labels (all characters evaluated in LMBCS code order)
Values (in numerical order)

Numbers First
Blank cells
Values (in numerical order)
Labels beginning with

a space
numbers (in numerical order)
letters (in alphabetical order, lowercase letters before uppercase)
other characters (in LMBCS code order)

Numbers Last
Blank cells
Labels beginning with

a space
numbers (in numerical order)
letters (in alphabetical order, lowercase letters before uppercase)
other characters (in LMBCS code order)

Values (in numerical order)

1-2-3 ignores apostrophes and hyphens when these characters appear in entries. For example, 1-2-3 
places Olden before O'Leary.

See also
Install Glossary
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1-2-3 User Preferences
Changes settings that affect the display and behavior of 1-2-3 in the current and in future sessions. 
These settings are stored in the 123R4.INI file as default settings and take effect automatically whenever
you start 1-2-3.

Note You can change these settings from within 1-2-3 with Tools User Setup.

1. Under Options, select one or more options.

* Drag-and-drop cells lets you move and copy cells with the mouse.

* Use Automatic format sets the 1-2-3 default format to Automatic.

To change the default format for new worksheets to General, select this option to remove the 
check mark.

* Save files every: xx minutes automatically saves all active files, according to the time interval you 
specify.

* Undo turns Edit Undo on or off.

* Run autoexecute macros tells 1-2-3 to run autoexecute macros when you open files that contain 
the macros.

* Beep on error sets the computer's bell to sound when errors occur or when the {Beep} command 
is executed in a macro.

Note Sound must be enabled on the Windows Control Panel.

2. Specify a number in the "Number of recent files to show" text box indicating how many of the most 
recently opened files you want listed on the File pull-down menu. You can open a file directly from the
pull-down.

3. Enter the default directory for 1-2-3 files in the Worksheet directory text box.

4. Choose OK.

See also
Install Glossary



1-2-3 User Preferences
Changes settings that affect the display and behavior of 1-2-3 in the current and in future sessions. 
These settings are stored in the 123R4.INI file as default settings and take effect automatically whenever
you start 1-2-3.

Note You can change these settings from within 1-2-3 with Tools User Setup.

1. Under Options, select one or more options.

* Drag-and-drop cells lets you move and copy cells with the mouse.

* Use Automatic format sets the 1-2-3 default format to Automatic.

To change the default format for new worksheets to General, select this option to remove the 
check mark.

* Save files every: xx minutes automatically saves all active files, according to the time interval you 
specify.

* Undo turns Edit Undo on or off.

* Run autoexecute macros tells 1-2-3 to run autoexecute macros when you open files that contain 
the macros.

* Beep on error sets the computer's bell to sound when errors occur or when the {Beep} command 
is executed in a macro.

Note Sound must be enabled on the Windows Control Panel.

2. Specify a number in the "Number of recent files to show" text box indicating how many of the most 
recently opened files you want listed on the File pull-down menu. You can open a file directly from the
pull-down.

3. Choose OK.



Selecting DataLens Drivers
DataLens lets you read data from and write data to external tables without leaving 1-2-3.

1. Select one or more of the following DataLens drivers.

* SQL Server is compatible with Microsoft SQL Server and Sybase SQL Server.

* Paradox is compatible with the table format of Paradox Release 3.0 and Release 3.5.

* dBASE is compatible with the table format of dBASE IV and dBASEIII Plus.

* IBM Database Manager is compatible with the OS/2 Database Manager Release 2.0.

* Informix is compatible with Informix Release 1.0.

2. Choose OK or press ENTER.

Note for network administrators
If you are a network administrator installing 1-2-3 on a server, see Customizing the DataLens 
Registration File.

See also
Install Glossary



Customizing the DataLens Registration File
1-2-3 uses the registration file in the program directory on the server unless a user creates a customized 
registration file in the personal directory. 1-2-3 looks in the user's personal directory first for the 
registration file and then looks in the program directory on the server.

A user can also instruct 1-2-3 to use the registration file in the program directory and the customized 
registration file simultaneously.

Using the registration files in the program and personal directory
1. The administrator maintains a registration file named LOTUS.BCF in the program directory.

2. The user creates a customized registration file and names it name.BCF, where name can be any 
name except LOTUS.

3. At the operating system prompt or in the user's AUTOEXEC.BAT file, the user enters the following 
command.

set lotusbcf=drive:\path\name.BCF

Note    Neither the directory that contains the customized registration file nor the personal directory can 
contain a file named LOTUS.BCF, or 1-2-3 will use that version of LOTUS.BCF instead of the version in 
the program directory. If a user copied LOTUS.BCF from the program directory in order to customize that
file, he or she should rename the file.





Customized Install
You must specify which 1-2-3 program files you want Install to transfer, and the disk drive and directory 
name for the 1-2-3 directory that will store the 1-2-3 program files.

1. Select a disk drive from the "Drives and space" drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the 1-2-3 program files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space for the 1-2-3 program files are displayed in 
parentheses.

2. Install displays the default 1-2-3 directory name, \123R4W, in the Program Directory text box.

Lotus recommends that you accept the default 1-2-3 directory name, but you can change it.

If you change the 1-2-3 directory name, remember that the directory name cannot contain more than 
eight characters. If you use subdirectories in your path, each subdirectory name cannot contain more 
than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Under Features to Install, select one or more of the following options:

* 1-2-3 Release 4 is the 1-2-3 program.

* Additional Features are tools and programs that enhance the power and usability of 1-2-3.

Some features, such as Spell Check, can be used from within 1-2-3. Others, such as Lotus Dialog
Editor, are separate programs.

* Sample and Help Files include sample worksheet files, an interactive tutorial, an animated tour, 
and detailed @function and macro Help files.

* DataLens Drivers let you read data from and write data to external tables without leaving 1-2-3.

4. Choose OK or press ENTER.

See also
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Specifying Files and Directories
When you install 1-2-3 on a server, you must specify the disk drive and directory name of the 1-2-3 
directory that will store the 1-2-3 files, then make the directory accesible to users.

Note    When installing 1-2-3 on a drive on a server, be sure that you have write access to the current 
directory.

Specifying the drive and directory
1. Select a disk drive from the "Drives and space" drop-down box.

The drop-down box lists all drives connected to the server and displays the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the 1-2-3 program files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note    Drives that do not contain enough space for the 1-2-3 program files are displayed in 
parentheses.

2. Install displays the default 1-2-3 directory name, \123R4W, in the "Program Directory" text box.

Lotus recommends that you accept the default 1-2-3 directory name, but you can change it.

If you change the 1-2-3 directory name, remember that the directory name cannot contain more than 
eight characters. If you use subdirectories in your path, each subdirectory name cannot contain more 
than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

4. Under Features to Install, select one or more of the following options:

* 1-2-3 Release 4 is the 1-2-3 program.

* Additional Features are tools and programs that enhance the power and usability of 1-2-3.

Some features, such as Spell Check, can be used from within 1-2-3. Others, such as Lotus Dialog
Editor, are separate programs.

* Sample and Help Files include sample worksheet files, an interactive tutorial, an animated tour, 
and detailed @function and macro Help files.

* DataLens Drivers let you read data from and write data to external tables without leaving 1-2-3.

5. Adobe Type Manager (ATM) uses PostScript outline font technology to display and print high-quality 
fonts. Lotus recommends that you transfer ATM to your 1-2-3 Release 4 program directory now. To 
transfer ATM, select the Adobe Type Manager check box.

6. Choose OK or press ENTER.

Making the program directory accessible to users
After the server directories are created, you need to use your network software to make the directories 
accessible to network users. This process involves giving each directory a network name and assigning 
access privileges to it. See Creating the program directory on your network for recommended 
sharenames, where applicable, and access privileges for supported networks.

Creating the program directory on your network
For information about access privileges and share names for your network, select your network from the 



following list.

Artisoft LANtastic version 4.1

Banyan VINES version 5.5

DEC PATHWORKS version 4.1

IBM LAN Server version 3.0

Microsoft LAN Manager version 2.1a or 2.2

NCR StarGroup 3.5 version 2.1A

Novell NetWare 386 version 3.11

Novell SFT NetWare 286 version 2.15c

Novell Advanced NetWare 286 version 2.15c

Novell NetWare 286 version 2.2



Selecting a Diskette Drive
Install needs to transfer files from the 1-2-3 disks to your 1-2-3 directory. To do this, Install needs to know
the letter of the diskette drive you are using.

1. Enter the diskette-drive letter in the Transfer from text box.

You must specify the letter of a diskette drive, not a hard-disk drive.

2. Choose OK or press ENTER.

See also
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Adding 1-2-3 Icons to a Program Manager Group
Install adds icons for the 1-2-3 programs to the Program Group you choose. These icons let you select 
the programs you have installed from the Windows Program Manager.

1. Select a Program Group from the Group Name drop-down box.

To add the icons to an existing Program Group, click the arrow of the drop-down box or press 
ALT+DOWN. Then select the group name by clicking it or by highlighting the group name and pressing 
ENTER.

To create a new group for the icons, type the new group name.

2. Unless you remove the check from the check box next to an icon, Install adds the following icons to 
the Program Group you selected in step 1:

* 1-2-3 Release 4 adds the 1-2-3 Release 4 icon.

* View Product Updates adds a Windows Notepad icon that lets you view the 1-2-3 Release 4 
README.TXT file.

* Lotus Dialog Editor adds the Lotus Dialog Editor icon.

* Tour adds the 1-2-3 Release 4 aminated tour icon.

* Install adds the 1-2-3 Release 4 Install program icon.

* Tranlsate adds the Translate utility icon.

* Catalog Tool adds IBM Database Manager Catalog Tool icon.

If you installed the IBM Database Manager DataLens Driver, select Catalog Tool.

* Macro Translator adds the Macro Translator icon.

3. Choose OK or press ENTER.

See also
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Adding 1-2-3 Icons to a Program Manager Group
Install adds icons for the 1-2-3 programs to the Program Group you choose. These icons let you select 
the programs you have installed from the Windows Program Manager.

1. Select a Program Group from the Group Name drop-down box.

To add the icons to an existing Program Group, click the arrow of the drop-down box or press 
ALT+DOWN. Then select the group name by clicking it or by highlighting the group name and pressing 
ENTER.

To create a new group for the icons, type the new group name.

2. Unless you remove the check from the check box next to an icon, Install adds the following icons to 
the Program Group you selected in step 1:

* Server Install adds the 1-2-3 Release 4 Server Install program icon.

* Licenser adds the Licenser utility icon.

* View Product Updates adds a Windows Notepad icon that lets you view the 1-2-3 Release 4 
README.TXT file.

* Lotus Dialog Editor adds the Lotus Dialog Editor icon.

* Tour adds the 1-2-3 Release 4 aminated tour icon.

* Node Install adds the 1-2-3 Release 4 Node Install program icon.

* Tranlsate adds the Translate utility icon.

* Catalog Tool adds IBM Database Manager Catalog Tool icon.

If you installed the IBM Database Manager DataLens Driver, select Catalog Tool.

* Macro Translator adds the Macro Translator icon.

3. Choose OK or press ENTER.

See also
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Main Menu - Installing from a Diskette
Main Menu lets you install 1-2-3 Release 4 on your computer or on a network server, read product 
updates, or change your country driver.

1. Choose one of the following command buttons.

* "Install 1-2-3" transfers the 1-2-3 program files to your computer. If this is the first time you are 
using Install, select this option now.

* "Install 1-2-3 on a server" transfers the 1-2-3 program files to a server. Choose this option only if 
you are a network administrator installing 1-2-3 on a network server.

* "View product updates" uses Notepad to show you the 1-2-3 Release 4 update file, 
README.TXT.

* "Choose country driver and sort order" lets you change the country driver and collating sequence 
1-2-3 uses.

See also
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Main Menu - Installing from a Hard Disk or Server
Main Menu lets you install 1-2-3 Release 4 on your computer, read product updates, or change your 
country driver.

1. Choose one of the following command buttons.

* "Install 1-2-3" transfers the 1-2-3 program files to your computer. If this is the first time you are 
using Install, select this option now.

* "View product updates" uses Notepad to show you the 1-2-3 Release 4 update file, 
README.TXT.

* "Choose country driver and sort order" lets you change the country driver and collating sequence 
1-2-3 uses.

See also
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1-2-3 Release 4 Install Program

Installing 1-2-3 on a Stand-Alone Computer
Installing 1-2-3 on a Network Server
lnstalling 1-2-3 on a Network Node



Installing 1-2-3 on a Stand-Alone Computer

Recording Your Name and Company Name
Main Menu - Installing from a Diskette
Main Menu - Installing from a Hard Disk or Server
Type of Installation
Default Install: Specifying the 1-2-3 Directory
Customized Install: Specifying Files and Directories
Specifying the Lotus Common Directory
Adding 1-2-3 Icons to a Program Manager Group
1-2-3 User Preferences
Choose Country Driver and Sort Order



Installing 1-2-3 on a Network Server

Network-Specific Installation
Recording Your Name and Company Name
Main Menu - Installing from a Diskette
Main Menu - Installing from a Hard Disk or Server
Server Install: Specifying Files and Directories
Specifying the Licenser Utility Directory
Specifying the License Directory
Specifying the Lotus Common Directory
Adding 1-2-3 Icons to a Program Manager Group
1-2-3 User Preferences
Choose Country Driver and Sort Order



Installing 1-2-3 on a Network Node

Recording Your Name and Company Name
Main Menu - Installing from a Hard Disk or Server
Type of Installation
Default Install: Specifying Your Personal Directory
Customized Install: Specifying Your Personal Directory
Specifying the Drive for the Lotus Common Directory
Adding 1-2-3 Icons to a Program Manager Group
Choose Country Driver and Sort Order





Paradox Network Information
1. If you will be accessing shared Paradox tables on a network, enter the drive and path of 

PARADOX.NET (for example, P:\PDOXDATA) in the text box.

If you will not be sharing these tables with other users, remove the check from the check box.

2. Choose OK or press ENTER.

See also
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Default Install: Specifying Your Personal Directory
You must specify the disk drive and directory name of the personal directory that will store the 1-2-3 
configuration files.

1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the configuration files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space for the configuration files are displayed in 
parentheses.

2. Install displays the default 1-2-3 personal directory name, \123W, in the Personal Directory text box.

If you change the personal directory name, remember that the directory name cannot contain more 
than eight characters. If you use subdirectories in your path, each subdirectory name cannot contain 
more than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

See also
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Customized Install: Specifying Your Personal Directory
You must specify the disk drive and directory name of the personal directory that will store the 1-2-3 
configuration files.

1. Select a disk drive from the Drives and space drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the configuration files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space for the configuration files are displayed in 
parentheses.

2. Install displays the default 1-2-3 personal directory name, \123W, in the Personal Directory text box.

If you change the personal directory name, remember that the directory name cannot contain more 
than eight characters. If you use subdirectories in your path, each subdirectory name cannot contain 
more than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Under Features to Install, select one or more of the following options:

* Configuration files tell 1-2-3 how to work correctly with your default settings..

* Sample Worksheets are worksheet files that the Tutorial, Solver and Macros Help, and What's 
New use to help you learn 1-2-3 Release 4.

4. Choose OK or press ENTER.

See also
Install Glossary



Specifying the 1-2-3 Directory
You must specify the disk drive and directory name of the 1-2-3 directory that will store the 1-2-3 program
files.

1. Select a disk drive from the "Drives and space" drop-down box.

The drop-down box lists all drives connected to your system and gives the available disk space on 
each. The drive you see is the default drive: the first drive Install found that contained enough space 
for the 1-2-3 program files.

To see additional drives, click the arrow of the drop-down box, or press ALT+DOWN. To select a drive 
that is not the default, click it, or highlight it and then press ALT+UP.

Note Drives that do not contain enough space for the 1-2-3 program files are displayed in 
parentheses.

2. Install displays the default 1-2-3 directory name, \123R4W, in the "Program Directory" text box.

Lotus recommends that you accept the default 1-2-3 directory name, but you can change it.

If you change the 1-2-3 directory name, remember that the directory name cannot contain more than 
eight characters. If you use subdirectories in your path, each subdirectory name cannot contain more 
than eight characters.

The name cannot contain spaces or the following characters:

[ ] ; , ? * : " + = < > |

3. Choose OK or press ENTER.

See also
Install Glossary



Selecting Help and Sample Files
1. Select one or more of the following files.

* Sample Worksheets are worksheet files that the Tutorial, Solver and Macros Help, and What's 
New use to help you learn 1-2-3 Release 4.

* Detailed Macro Help contains a Help topic for each macro command. Each topic contains the 
definition, explanation of arguments, notes, uses, examples, and cross-references to related 
macro commands.

* Detailed @Function Help contains a Help topic for each @function. Each topic contains the 
definition, explanation of arguments, notes, uses, examples, and cross-references to related 
@functions.

* The online Tutorial provides interactive lessons that teach you the basics of 1-2-3 Release 4. After
you install the Tutorial, 1-2-3 adds this item to the Help pull-down menu.

* The animated, online Guided Tour explores basic worksheet concepts, charting, databases, 
multiple-sheet files, and other major 1-2-3 Release 4 features. The Guided Tour also includes a 
special section for users upgrading from previous releases of 1-2-3.

The Guided Tour is available only to Windows 3.1 users.

2. Choose OK or press ENTER.

See also
Install Glossary



SQL Server Name
1. Enter the name of the network server on which SQL Server is installed.

2. Choose OK or press ENTER.



Type of Installation
You can choose Default Install, Customized Install, or Install for Laptops.

Default Install
Customized Install
Install for Laptops



Default Install
Install asks you to specify a disk drive and directory name for the 1-2-3 directory. Install then does the 
following:

Transfers files and features

Transfers Help and sample files

Transfers DataLens drivers

Adds icons to the Windows Program Manager

Sets 1-2-3 initial default settings

Files and features
Install transfers the 1-2-3 program files, plus the following additional features:

* Audit highlights or produces a report on all formulas, or the relationships of values and formulas, in 
the current file or in all active files; also highlights or produces a report on circular references, file 
links, or DDE links.

* Backsolver finds values for one or more cells that make the result of a formula equal to a value you 
specify.

* Solver analyzes data in a worksheet and shows you a variety of possible answers to a problem you 
define. An answer satisfies constraints you specify. You can start with any worksheet model that 
contains formulas and values you want to experiment with.

* Lotus Dialog Editor lets you create custom dialog boxes for use in 1-2-3.

* Macro Translator translates each {ALT} keystroke command in a 1-2-3 for Windows release 1 macro 
to its fully qualified 1-2-3 Release 4 equivalent.

* The Translate utility is a program that lets you convert data files to and from the 1-2-3 Release 4 file 
format.

* Version Manager for Lotus Notes.

Note Install only transfers this feature if Lotus Notes is installed on your computer.

* Spell Check checks for misspelled and repeated words in your worksheets.

Help and sample files
* Sample Worksheets are worksheet files that the Tutorial, Solver and Macros Help, and What's New 

use to help you learn 1-2-3 Release 4.

* Detailed Macro Help contains a Help topic for each macro command. Each topic contains the 
definition, explanation of arguments, notes, uses, examples, and cross-references to related macro 
commands.

* Detailed @Function Help contains a Help topic for each @function. Each topic contains the definition,
explanation of arguments, notes, uses, examples, and cross-references to related @functions.

* The online Tutorial provides interactive lessons that teach you the basics of 1-2-3 Release 4. After 
you install the Tutorial, 1-2-3 adds this item to the Help pull-down menu.

* The animated, online Guided Tour explores basic worksheet concepts, charting, databases, multiple-
sheet files, and other major 1-2-3 Release 4 features. The Guided Tour also includes a special 
section for users upgrading from previous releases of 1-2-3.

The Guided Tour is available only to Windows 3.1 users.

DataLens drivers



DataLens lets you read data from and write data to external tables without leaving 1-2-3. Install transfers 
the dBASE DataLens driver.

Program icons
Install places the icons for 1-2-3, Install, Macro Translator, Lotus Dialog Editor, and View Product 
Updates (readme file) in a Program Group named Lotus Applications.

1-2-3 initial default settings
Install sets the 1-2-3 initial default settings:

* Enables drag-and-drop, so you can move and copy cells with the mouse.

* Sets the 1-2-3 default format to Automatic.

* Turns Edit Undo on.

* Runs autoexecute macros when you open files that contain the macros.

* Sets the computer's bell to sound when errors occur or when the {Beep} command is executed in a 
macro.

Note Sound must be enabled on the Windows Control Panel.

* Lists the five most-recently opened files on the File pull-down menu. You can open a file directly from 
the pull-down.

See also
Install Glossary
Type of Installation



Customized Install
Install asks you to specify which groups of 1-2-3 program files you want to transfer, as well as the disk 
drive and directory name for the 1-2-3 directory. Install also asks you to specify the 1-2-3 initial default 
settings.

See also
Install Glossary
Type of Installation



Install for Laptops
Install asks you to specify a disk drive and directory name for the program directory where the 1-2-3 
Release 4 files will reside. Install then does the following:

* Transfers the 1-2-3 program files to the 1-2-3 directory.

Install does not transfer any additional features.

* Sets the 1-2-3 Release 4 initial default settings:

* Enables drag-and-drop, so you can move and copy cells with the mouse.

* Sets the 1-2-3 default format to Automatic.

* Turns Edit Undo on.

* Runs autoexecute macros when you open files that contain the macros.

* Sets the computer's bell to sound when errors occur or when the {Beep} command is executed in 
a macro.

Note Sound must be enabled on the Windows Control Panel.

* Lists the five most-recently opened files on the File pull-down menu. You can open a file directly 
from the pull-down.

See also
Install Glossary
Type of Installation



Type of Installation
You can choose Default Install or Customized Install.

Default Install
Customized Intall



Default Install
Install asks you to specify a disk drive and directory name for your personal directory. Install then does 
the following:

Transfers the 1-2-3 configuration files

Transfers sample worksheet files

Adds icons to the Windows Program Manager

See also
Install Glossary
Type of Installation



Customized Install
Install asks you to specify a disk drive and directory name for your personal directory. Install also asks 
you to specify whether to transfer configuration files and sample worksheet files to your personal 
directory.

See also
Install Glossary
Type of Installation



Glossary

autoexecute macro
A macro named \0 (backslash zero) that 1-2-3 executes automatically if the Run autoexecute macros 
option in Tools User Setup is selected when you open a file that contains the \0 macro.

check box
In a dialog box, the box that turns the associated option on and off. When an X appears in the box, the 
option is on. When the box is blank, the option is off. When the box is filled, 1-2-3 cannot determine the 
state of the option for the current selection.

To change the check box for a selected option, click the check box, press the space bar, or press the 
underlined letter. 

collating sequence
The order 1-2-3 uses to arrange entries beginning with letters, numbers, symbols, or blank cells when 
you sort data using Data Sort. Use Install to change the collating sequence.

command button
In a dialog box, an oblong button labeled with a command. The command is carried out when you click 
the button, press ENTER when the button is selected, or press the key corresponding to the underlined 
letter in the command name.

default directory
The directory that 1-2-3 automatically uses for worksheet files when you start 1-2-3. Initially, 1-2-3 uses 
the directory you specified in the Install program, but you can specify a different default directory with 
Tools User Setup.

dialog box
A window that requests information needed to carry out a command. When 1-2-3 displays a dialog box, 
you must complete it or cancel it before you can go to any other task. When a dialog box component is 
not available, it is dimmed.

directory
A subdivision of a disk. You can create and name a directory and store related files in it when you save 
the files on a disk. Doing this makes finding and reading the files easier.

directory name
The name of a subdivision of a disk. In 1-2-3 documentation, a \ (backslash) separates the directory 
names in a path from each other and from the file name. For example, in C:\FEBRUARY\BUDGET.WK4, 
the directory name is FEBRUARY, and the file name is BUDGET.WK3.

drive name
The two characters (a letter and a colon) that identify the disk drive. For example, C: is the name of drive 
C, the hard disk on your computer.

driver
A program that tells 1-2-3 how to communicate with a piece of hardware, such as a printer or monitor, or 
how to perform a particular task, such as reading data in an external database table. 

drop-down box



In a dialog box, a box that shows a single option until you select the scroll arrow to the right of the option;
then a list of options drops down. Some drop-down boxes let you enter text in the top box; in others, you 
must select an option from the list.

external database table
A table in an external database that contains a collection of related information. External databases are 
stored in files that are not 1-2-3 files, such as dBASE IV, Paradox, or SQL Server files.

initial setting
A setting 1-2-3 uses the first time you start 1-2-3 Release 4. The initial settings remain as the default 
settings for 1-2-3 unless you change them. 

list box
A list of choices that appears in a dialog box. If there are more choices than can fit in the visible area of 
the list box, use the scroll bar or the arrow keys to bring the other choices into view.

option button
In a dialog box, a round selection button. You can select only one option button in a group of related 
options. 

path
The root directory and all the subdirectories in which you save a file. In C:\1993\BUDGET.WK4, C:\1993\ 
is the path for the file BUDGET.WK4.

subdirectory
A subdivision of another directory. In C:\1993\JUNE93\BUDGET.WK4, JUNE93 is a subdirectory of C:\
1993.

text box
A rectangular area in some dialog boxes in which you enter information and edit text required by a 
command.



Recording Your Name and Company Name
Install uses the information you enter in this dialog box to record your name and company name on your 
original copy of 1-2-3 Release 4. Install asks you to enter your name each time you run Install from the 
Install diskette.

1. Enter your name in the "Enter your name" text box.

2. Enter your company name in the "Enter your company name" text box. If you do not have a company
name, type your own name a second time.

Limit the names to 30 characters each.

Note If you are installing 1-2-3 on a node, your network administrator has already entered your 
company or server name.

3. Choose OK or press ENTER when you finish entering both names.

See also
Install Glossary





Network-specific Installation
For information about installing 1-2-3 on a network, using the mouse, point to the network name and click
the mouse button.

Using the keyboard, press TAB until the network is highlighted, and then press ENTER. 

Artisoft LANtastic version 4.1

Banyan VINES version 5.5

DEC PATHWORKS version 4.1 or later

IBM LAN Server version 3.0

Microsoft LAN Manager version 2.1a or 2.2

NCR StarGroup 3.5 version 2.1A

Novell NetWare 386 version 3.11

Novell SFT NetWare 286 version 2.15c

Novell Advanced NetWare 286 version 2.15c

Novell NetWare 286 version 2.2



Artisoft LANtastic version 4.1
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on an Artisoft LANtastic version 4.1 server, Lotus recommends that you organize 
the server directories as follows:

1-2-3 Program directory

recommended share name - 123R4W

access - read (R)

Lotus Common directory

recommended share name - LOTUSAPP

access - read (R)

Note    After installing 1-2-3, users will not be able to use 1-2-3 unless you make each file in the Lotus
Common directory a read-only file. To do so, use the DOS ATTRIB command. For more information, 
see your DOS manual.

Licenser Utility directory

recommended share name - LICENSER

access - none

License directory

recommended share name - LOTSHARE

access - Read-Write-Create (RWC)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide
Chapter 2, "Installing Lotus Applications"



Banyan VINES version 5.1 (0) or later
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Banyan VINES version 5.1 (0) or later server, Lotus recommends that you 
organize the server directories as follows:

1-2-3 Program directory

recommended StreetTalk item name - 123R4W@GROUP@ORGANIZATION

access - read (R)

Lotus Common directory

recommended StreetTalk item name - LOTUSAPP@GROUP@ORGANIZATION

access - read (R)

Licenser Utility directory

recommended StreetTalk item name - LICENSER@GROUP@ORGANIZATION

access - none

License directory

recommended StreetTalk item name - LOTSHARE@GROUP@ORGANIZATION

access - Modify (M)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



DEC PATHWORKS version 4.1 or later
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a DEC PATHWORKS version 4.1 server, Lotus recommends that you organize
the server directories as follows:

1-2-3 Program directory

recommended application file service name - 123R4W

access - read (R)

Lotus Common directory

recommended application file service name - LOTUSAPP

access - read (R)

Licenser Utility directory

recommended application file service name - LICENSER

access - none

License directory

recommended application file service name - LOTSHARE

access - Read-Write-Create (RWC)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



IBM LAN Server version 3.0
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on an IBM LAN Server version 3.0 server, Lotus recommends that you organize 
the server directories as follows:

1-2-3 Program directory

recommended alias - 123R4W

access - read (R)

Lotus Common directory

recommended alias - LOTUSAPP

access - read (R)

Licenser Utility directory

recommended alias - LICENSER

access - none

Path to License directory

recommended alias - LOTSHARE

access - Read-Write-Create (RWC)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



Microsoft LAN Manager version 2.1a or 2.2 or later
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Microsoft LAN Manager version 2.1a or 2.2 or later server, Lotus 
recommends that you organize the server directories as follows:

1-2-3 Program directory

recommended share name - 123R4W

access - read (R)

Lotus Common directory

recommended share name - LOTUSAPP

access - read (R)

Licenser Utility directory

recommended share name- LICENSER

access - none

License directory

recomended directory path - x:\LOTSHARE

recommended share name - LICENSE

access - Create-Delete-Read-Change Attributes-Write (CDRAW)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide
Chapter 2, "Installing Lotus Applications"



NCR StarGroup 3.5 version 2.1A
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on an NCR StarGroup 3.5 version 2.1A server, Lotus recommends that you 
organize the server directories as follows:

1-2-3 Program directory

recommended share name - 123R4W

access - read (R)

Lotus Common directory

recommended share name - LOTUSAPP

access - read (R)

Note    After installing 1-2-3, users will not be able to use 1-2-3 unless you make each file in the Lotus
Common directory a read-only file. To do so, use the DOS ATTRIB command. For more information, 
see your DOS manual.

Licenser Utility directory

recommended share name - LICENSER

access - none

License directory

recommended share name - LOTSHARE

access - read-write

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide
Chapter 2, "Installing Lotus Applications"



Novell NetWare 386 version 3.11
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Novell Netware 386 version 3.11 or 4.0 server, Lotus recommends that you 
organize the server directories as follows:

1-2-3 Program directory

access - Read-File Scan (RF)

Lotus Common directory

access - Read-File Scan (RF)

Licenser Utility directory

access - none

License directory

access - Create-Erase-File Scan-Modify-Read-Write (CEFMRW)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



Novell SFT NetWare 286 version 2.15c
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Novell SFT Netware 286 version 2.15c server, Lotus recommends that you 
organize the server directories as follows:

1-2-3 Program directory

access - Read-Open-Search (ROS)

Lotus Common directory

access - Read-Open-Search (ROS)

Licenser Utility directory

access - none

License directory

access - All (RWOCDPSM)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



Novell Advanced NetWare 286 version 2.15c
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Novell Advanced Netware 286 version 2.15c server, Lotus recommends that 
you organize the server directories as follows:

1-2-3 Program directory

access - Read-Open-Search (ROS)

Lotus Common directory

access - Read-Open-Search (ROS)

Licenser Utility directory

access - none

License directory

access - All (RWOCDPSM)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"



Novell NetWare 286 version 2.2
Note    To print this information, choose File Print Topic.

When you install 1-2-3 on a Novell Netware 286 version 2.2 server, Lotus recommends that you organize
the server directories as follows:

1-2-3 Program directory

access - Read-File Scan (RF)

Lotus Common directory

access - Read-File Scan (RF)

Licenser Utility directory

access - none

License directory

access - Create-Erase-File Scan-Modify-Read-Write (CEFMRW)

Note    Share the directory that contains the license directory rather than the license directory itself.    
For example, if LOTSHARE is the directory that contains the license directory 123W.V40, share 
LOTSHARE, not 123W.V40.

See also

Network Administrator's Guide

Chapter 2, "Installing Lotus Applications"


